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I nt I'Od u CﬁOn (Ask a Question)

Libero® System-on-Chip (SoC) software provides a fully integrated Field Programmable Gate Array (FPGA)
design environment. However, a few users might want to use third-party synthesis and simulation tools outside
the Libero SoC environment. Libero is now integrated into the FPGA design environment. It is recommended to
use Libero SoC to manage the entire FPGA design flow.

This user guide describes the Custom Flow, a process to integrate Libero as a part of the larger FPGA design
flow.

Supported Device Families
The following table lists the device families that Libero SoC supports. However, some information in this guide
might only apply to a specific family of devices. In this case, such information is clearly identified.

Table 1. Device Families Supported by Libero® SoC

SmartFusion® 2 SmartFusion 2 device addresses the fundamental requirements for advanced security, high reliability, and low power in
critical industrial, military, aviation, communications, and medical applications.

IGLOO® 2 IGLOO 2 device is a low-power mixed-signal programmable solution.
RTG4™ RTG4 is Microchip's family of radiation-tolerant FPGAs.


https://www.microchip.com/askaquestion?pub_guid=GUID-7E5C0B1E-64A3-47B9-8651-373CCC35329A&pub_lang=en-US&pub_ver=16&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-661937A3-FC73-444E-BCF2-84F578D3ADFC&cover_title=SmartFusion%202%2C%20IGLOO%202%2C%20RTG4%20Custom%20Flow%20User%20Guide&tech_support_link=NA&revision_letter=P&source=PDF&title=Introduction
https://www.microchip.com/en-us/products/fpgas-and-plds/system-on-chip-fpgas/smartfusion-2-fpgas
https://www.microchip.com/en-us/products/fpgas-and-plds/fpgas/igloo-2-fpgas
https://www.microchip.com/en-us/products/fpgas-and-plds/radiation-tolerant-fpgas/rtg4-radiation-tolerant-fpgas
https://microchip.com
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1- OVEI‘ViEW (Ask a Question)

While Libero SoC provides a fully-integrated end-to-end design environment to develop SoC and

FPGA designs, it also provides the flexibility to run synthesis and simulation with third-party tools
outside the Libero SoC environment. However, some design steps must remain within the Libero
SoC environment.

The following table lists the major steps in the FPGA design flow and indicates the steps for which
Libero SoC must be used.

Table 1-1. FPGA Design Flow

Design Entry: HDL No Use third-party HDL editor/checker tool outside
Libero® SoC if desired.

Design Entry: Configurators Yes Create first Libero project for IP catalog core
component generation.

Design Entry: System Builder Yes Stay in first Libero project

(SmartFusion® 2 and IGLOO® 2 devices

only)

Automatic PDC or SDC constraint No Derived constraints need all HDL files and a

generation derive_constraints utility when performed outside

of Libero SoC, as described in Appendix D—Derive
Constraints.

Simulation No Use third-party tool outside Libero SoC, if
desired. Requires download of pre-compiled
simulation libraries for target device, target
simulator, and target Libero version used for
backend implementation.

Synthesis No Use third-party tool outside Libero SoC if desired.
Design Implementation: Manage Yes Create second Libero project for the backend
Constraints, Compile Netlist, Place-and- implementation.

Route (see Figure 1-1)

Timing and Power Verification Yes Stay in second Libero project

Programming File Generation Yes Stay in second Libero project

Firmware Generation (SmartFusion 2 Yes Stay in second Libero project

only)

Firmware Debug (SmartFusion 2 only) No Use third-party tool outside Libero SoC if desired.

Important: You must download precompiled libraries listed under the Compiled
Simulation Libraries for SmartFusion® 2, IGLOO® 2, and RTG4™ section on the Libero
SoC Documentation page to use a third-party simulator.

In a CPLD or pure Fabric FPGA flow, enter your design using HDL or schematic entry and pass that
directly to the synthesis tools. The flow is still supported. However, SmartFusion® 2, IGLOO® 2, and
RTG4™ FPGAs have significant proprietary hard IP blocks requiring the use of configuration cores
(SgCores) from the Libero SoC IP catalog. Special handling is required for the following blocks that
comprise SoC functionality.

*  SmartFusion 2 and IGLOO 2
- SmartFusion 2 MSS (includes MDDR and eNVM)

- IGLOO 2 HPMS (includes MDDR and eNVM)
- System Builder
- FDDR
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- SerDes
- Oscillator
- CCC
- RAMSs (TPSRAM, DPSRAM, URAM)
- TAMPER, and so on.
« RTG4
- uPROM
- SerDes
- SerDes INIT
- FDDR
- FDDRINIT
- RCOSC macro
- CCC
- RAMSs (TPSRAM, DPSRAM, URAM), and so on.

In addition to the preceding listed SgCores, there are many DirectCore soft IPs available for
various device families in the Libero SoC Catalog that use the FPGA fabric resources.

For design entry, if you use any one of the preceding components, you must use Libero SoC
for part of the design entry (Component Configuration), but you can continue the rest of your
Design Entry (HDL entry, and so on) outside of Libero. To manage the FPGA design flow outside
of Libero, follow the steps provided in the rest of this guide.

1.1. Component Life Cycle (s question)
The following steps describe the life cycle of an SoC component and provide instructions on handle

data:

1. Generate the component using its configurator in Libero SoC. This generates the following types
of data:
a. HDL files

b. Memory files
c. Stimulus and Simulation files
d

Component metadata such as component file manifest text file, register configuration files
(*.reg) for MDDR/FDDR/SerDes and *cfqg file for eNVM (SmartFusion 2 and IGLOO 2),
UPROM (RTG4)

e. Firmware drivers (*.h) files
f. Component SDC file

2. For HDL files, instantiate and integrate them in the rest of the HDL design using the external
design entry tool or process.

3. Supply memory files and stimulus files to your simulation tool.
Supply firmware drivers to your firmware project.

5. Supply Component SDC file to Derive Constraint tool for Constraint Generation. For more
information, see Appendix D—Derive Constraints for more details.

6. You must create a second Libero project, where you import the post-Synthesis netlist and your
component metadata (data files about the design components, such as register configuration
files and initialization files), thus completing the connection between what you generated and
what you program.
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1.2. Libero SoC Project Creation (asaauestion)

Some design steps must be run inside the Libero SoC environment (Table 1-1). For these steps
to run, you must create two Libero SoC projects. The first project is used for design component
configuration and generation, and the second project is for the physical implementation of the
top-level design.

+ The enhanced constraint flow is used for both the first project and the second (implementation)
project because the enhanced constraint flow offers the constraint manager to better manage all
design constraints (SDC Timing, 10 PDC, Floorplanning PDC, and Synthesis NDC constraints). The
creation, import, and editing of constraints and their association with individual design tools are
controlled in one single management tool—the Constraint Manager.

+ The enhanced constraint flow generates automatic SDC and PDC constraints for common cores
such as the CCC, OSC, SerDes, and so on. For RTG4 designs using the RTG4FCCCECALIB core,
the automatic constraint generation (Derive Constraints) generates netlist constraint files (NDC).
In addition, SDC files are generated for association with synthesize or compile netlist design
flow steps. The SDC, PDC, or NDC constraints of these cores are set from the top of the design
hierarchy with the full hierarchical path given. You do not need to traverse from the top of the
design hierarchy to set a constraint on these IP cores, nor do you need to worry about the syntax
of the SDC, PDC, or NDC constraints such as hierarchy and pin separators, design object names,
and so on.

+ The automatically generated constraints, when applied, increase the chance of timing closure
with less effort and fewer design iterations.

1-3. Custom FIOW (Ask a Question)

The following figure shows how Libero SoC is integrated as a part of the larger FPGA design

flow with the third-party synthesis and simulation tools outside the Libero SoC environment. The
following figure shows various steps involved in the flow, starting from design creation and stitching
all the way to programming the device. The figure also shows the data exchange (inputs and
outputs) that must occur at each design flow step.
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Figure 1-1. Custom Flow Overview
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Tip:
= 1.p Component Data Files and Memory Config Files:
a. Component Data Files and Memory Config Files:
i. SmartFusion 2/IGLOO 2: *. reg files for MDDR/FDDR/SerDes blocks.
b. Memory Config Files:
i. SmartFusion 2/IGLOO 2: ENVM. cfq.
ii. RTG4:UPROM.cfg.
2. *.memn file generation for Simulation for different families:

a. SmartFusion 2: padmssenvmgen. exe takes ENVM.cfg as input and
generates ENVM init.mem.

b. IGLOO 2: pa4mssenvmgen.exe takes * . reg files for MDDRR/FDDR/
SerDes blocks and ENVM. c£g as input and generates ENVM init.mem.

€. RTG4:paidrtupromgen.exe takes UPROM. cfg as input and generates
UPROM. mem.

The following are the steps in the custom flow:
1. Component configuration and generation:
a. Create a first Libero project (to serve as a Reference Project).

b. Select the Core from the Catalog. Double-click the core to give it a component name and
configure the component.

Important: For SmartFusion 2 and IGLOO 2 System Builder and
SmartFusion 2 MSS blocks, generate the component in the SmartDesign
canvas after configuration of the SmartFusion 2 MSS block and System
Builder block.

This automatically exports component data and files. A Component Manifests is also
generated. See Component Manifests for details. For more details, see Component
Configuration.

2. Complete your RTL design outside of the Libero:
a. Instantiate the component HDL files.
b. The location of the HDL files is listed in the Component Manifests files.

3. Generate SDC/PDC/NDC constraints for the components. Use Derive Constraints utility to
generate the floorplanning . *pdc (only for SmartFusion 2/IGLOO 2), the timing . *sdc, and
netlist constraints . *ndc (in RTG4 designs using RTG4FCCCECALIB core) files based on:

a. Component HDL files

b. Component SDC/NDC files

c. User HDL files

For more details, see Appendix D—Derive Constraints.

4. Synthesis tool/simulation tool:

a. Get HDL files, stimulus files, and component data from the specific locations as noted in the
Component Manifests.

b. Synthesize and simulate the design with third-party tools outside the Libero SoC.
5. Firmware tool (SmartFusion 2 only):
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a. Getdrivers from the specific locations as noted in the manifest.

b. Edit source code to enable run time initialization for specific components, compile firmware
project.
Create your second (Implementation) Libero Project.

7. Remove synthesis from the design flow tool chain (Project > Project Settings > Design Flow >
clear the Enable Synthesis check box) if it is a netlist file.

8. Import the design source files (post-synthesis *.edn or *.vm netlist from synthesis tool):

- For SmartFusion 2 and IGLOO 2, import post-synthesis *.edn or *.vm netlist (File >
Import > Others).

- Component metadata such as *. reg files for MDDR/FDDR/SerDes (SmartFusion 2 and
IGLOO 2), *.cfg file for eNVM (SmartFusion 2 and IGLOO 2), and * . c£g file for yPROM
(RTG4).

9. Import any Libero SoC block component files. The block files must be in the *. cxz file format.
For more information on how to create a block, see SmartFusion2, IGLOO2, and RTG4 Block Flow
User's Guide.

10. Import the design constraints:
- Import I/0 constraint files (Constraints Manager > I/OAttributes > Import).

- Import floorplanning * . pdc files (Constraints Manager > Floor Planner > Import). If
your design contains CoreConfigP (SmartFusion 2 and IGLOO 2), import the PDC file
generated with the Derive Constraints utility (generate SDC and PDC constraints for the
components).

- Import *. sdc timing constraint files (Constraints Manager > Timing >Import). Import the
SDC file generated through Derive Constraint tool.

- Import *.ndc constraint files (Constraints Manager > NetlistAttributes > Import), if any.
In RTG4 designs using the RTG4FCCCECALIB core, import the NDC file generated through
Derive Constraints utility outside of Libero.

11. Constraint file and tool association

- In the Constraint Manager, associate the *.pdc files to place and route, the *. sdc files to
place and route and timing verifications, and the *.ndc files to compile netlist.

12. Complete design implementation
- Place and route, verify timing and power.
13. Validate the design

- Validate the design on FPGA and debug as necessary using the design tools provided with
the Libero SoC design suite.
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2. Component Configuration (saauestion)

The first step in the custom flow is to configure your components using a Libero reference project
(also called first Libero project in Table 1-1). In subsequent steps, you will use data from this
reference project.

If you are using any components listed earlier, under the Overview in your design, perform the steps
described in this section.

If you are not using any of the above components, then write your RTL outside of Libero and directly
import it into your Synthesis and Simulation tools. Then proceed to the post-synthesis section and
only import your post-synthesis *.edn or *.vm netlist into your final Libero implementation
project (also called second Libero project in Table 1-1).

2.1. Component Configuration Using Libero (asaauestion)

After selecting the components that must be used from the preceding list, perform the following
steps:

1. Create a new Libero project (Core Configuration and Generation):
a. Select the Device and Family that you target your final design to.

b. If you use the SmartFusion 2 MSS, SmartFusion 2, or IGLOO 2 System Builder, make the
appropriate selection in the Use Design Flow section of the New Project window.

2. If you use Smart Fusion 2 or IGLOO 2 System Builder (for IGLOO 2, you must use the System
Builder to configure the HPMS, eNVM, MDDR, and FDDR):

a. Use the System Builder to select your components and configure your system.

b. Generate your system in the System Builder and promote all its ports to the top level after
instantiating in a SmartDesign canvas (select all ports, right-click and choose promote to top).

O Tip: You need the port names to connect the rest of your design to the
= generated system.

c. Instantiate and configure any CCC or SerDes blocks in the same top-level SmartDesign or in
another SmartDesign component. Again, promote any ports to top.

d. Generate any SmartDesign instances.

e. Double-click the Simulate tool (Pre-Synthesis) to invoke the simulator. Exit the simulator
once it is invoked—this step generates the simulation files necessary for your project.

Q Tip: You must perform this step if you want to simulate your design
outside Libero.

f. Save your project—this is your reference project.
3. If you do not use the System Builder (SmartFusion 2 only):

a. Ifyou select the SmartFusion 2 MSS in the Use Design Flow subsection (step 1.b), the
SmartFusion 2 MSS Configurator automatically opens. Otherwise, in the Design Flow
window, double-click Configure MSS.

i. Double-click the SmartFusion 2 MSS instance to open its configurator.
ii. Configure the SmartFusion 2 MSS as per your requirements.
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O Tip: If you use the eNVM or the MDDR, you must use the SmartFusion 2
= MSS to configure it.

iii. Save and generate the SmartFusion 2 MSS component.

O Tip: If you do not use the System Builder, and you have the
= SmartFusion 2 MSS (using MDDR) or FDDR or SerDes blocks in your
design, you must follow the next steps.

b. Construct the Peripheral Initialization architecture in your final design. For more details,
about Peripheral Initialization, see:

+ SmartFusion2 DDR Controller and Serial High Speed Controller Initialization
Methodology

+ SmartFusion2 DDR Controller and Serial High Speed Controller Standalone Initialization
Methodology

c. Instantiate and configure any FDDR, CCC, or SerDes blocks in the top-level SmartDesign. It is
not necessary to connect them to anything else—just promote any ports to top.

d. Generate all the SmartDesigns built in the preceding steps.

Double-click the Simulate tool (Pre-Synthesis) to invoke the simulator. Exit the simulator
after it is invoked; this step simply generates the simulation files necessary for your project.

Q Tip: You must perform this step if you want to simulate your design
outside Libero.

For more information, see Simulating Your Design.

f. Save your project—this is your reference project.

4. If you use SmartFusion 2, and any of the SmartFusion 2 MSS peripherals (MDDR, FDDR, or
SerDes), you must export your firmware project (SoftConsole/IAR/Keil) from this Libero
project. For more information, see Building Your Firmware Project.

5. If you use RTG4:

a. If you wantto use the SerDes and the FDDR blocks in your design with built-in Initialization
logic, configure and generate the corresponding INIT cores (NPSS_SERDES_IF_INIT,
PCIE_SERDES_IF_INIT, and RTG4FDDRC_INIT) from the Libero catalog.

b. If you want to use the SerDes and the FDDR blocks in your design without built-in

Initialization logic, configure and generate the corresponding peripheral cores from the
Libero catalog.

O Tip: If you are using SerDes and FDDR blocks in your design, but not their

= corresponding INIT cores, you must construct the Peripheral Initialization
architecture in your final design to initialize the RTG4 SerDes and the FDDR
blocks. For further details regarding Peripheral Initialization, see:

* RTG4™ High Speed Serial Interface Configuration User Guide

+ RTG4 DDR Memory Controller with Initialization Configuration User
Guide
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https://coredocs.s3.amazonaws.com/Libero/SgCore/FDDR/rtg4_fddr_init_config_ug_2.pdf

2.2.

c. Instantiate and configure any FDDR, CCC, OSC, or SerDes blocks in the top level SmartDesign.

It is not necessary to connect them to anything else — just promote any ports to top.
d. If you wantto use RTG4 pPROM, add the yPROM block to the top level SmartDesign.
e. Generate all the SmartDesigns built in the above steps.

f. Double-click Simulate (Pre-Synthesis) to invoke the simulator. Exit the simulator after it is
invoked; this step only generates the simulation files that are necessary for your project.

Tip: To generate pnPROM. men file (used for simulating the yPROM contents)
= from the nPrROM. cfg file (generated by the configurator) using a stand-

alone executable outside Libero, see Simulating Your Design. You must

perform this step if you want to simulate your design outside of Libero.

g. Save your project—this is your reference project.

O Tip: You must follow the DRCs for components that you instantiate. For

= example, if you have multiple SerDes instances in your design, make sure
that each SerDes instance is configured to select a different physical SerDes
block. Refer to the user guides for the respective component DRCs for
details.

Component Manifests (aska question)

When you generate your components, a set of files is generated for each component. The
Component Manifest Report details the set of files generated and used in each subsequent step
(Synthesis, Simulation, Firmware Generation, and so on). This report gives you the locations of all
the generated files needed to proceed with the Custom Flow. To the component manifest in the
Reports area: Click Design > Reports to open the reports tab. In the reports tab, you see a set of
manifest.txt files (Figure 1-1), one for each component you generated.

O Tip: You must set a component or module as 'root' to see the component
= manifest file contents in the Reports tab.

Alternatively, access the individual manifest report files for each core component generated

or SmartDesign component from <project>/component/work/<component name>/<instance
name>/<component name> manifest.txt Or <project>/component/work/<SmartDesign
name>/<SmartDesign name> manifest.txt. A access the manifest file contents of each
component generated from the new Components tab in Libero, where the file locations are
mentioned with respect to the project directory.
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Figure 2-1. Accessing Component Manifest Report Files from Libero Reports Tab (For SmartFusion 2 System

Builder)
Reports @ X l -
=l Project Summary Al 0Ermors 0 Warnings 01nfo
gdprojlog E] Q A 0
|- toplevelsd reports - - - - — - "
B Microsemi Corporation - Microsemi Libero Software Release v2021.2 (Version 2021.2.0.5) =
omponents
|- toplevelsd
’ Date : Wed Jun 30 00:14:23 2021
toplevelsd_manifest.txt ° PoWe 3 P
I toplevelsd_sb Project D.\]fesl(inz\gbproj
toplevelsd_sb_SYS_BLDxml Component :  toplevelsd s
Family  : SmartFusion2

toplevelsd_sb_CCC_0_configur...
toplevelsd_sb_manifest.txt

+]- toplevelsd_sb_MSS ) ) ) )
HDL source files for all Synthesis and Simulation tools:

/Designs/gdproj/component /work/toplevelsd_sb/CCC_0/toplevelsd_sb_CCC_0_FCCC.v
/Designs/gdproj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/coreahblite_addrdec.v
defaultslavesm.v

=]

/Designs/gdproj/component/Actel/DirectCore/CoreAHBLite/5.
/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/coreahblite_slavearbiter.v
/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/viog/core/coreahblite masterstage.v

2.100/rtl/vlog/core/coreahblite
2
2

/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1log/core/coreahblite_slavestage.v
2
2
1

/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1iog/core/coreahblite_matrixdxl6.v
/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/viog/core/coreahblite. v
/Designs/gdpro]/component/Actel/DirectCore/CoreConfigp/7.
/Designs/gdpro]/component/Actel/DirectCore/CoreResetP/7.1.100/rtl/vlog/core/coreresetp.v LI
/Designs/gdpro]/component/Actel/DirectCore/CoreResetP/7.1.100/rtl/vlog/core/coreresetp_pcie_hotreset.v
/Designs/gdproj/component/work/toplevelsd sb/FABDDR_0/toplevelsd_sb_FABDDR_O_FDDRC.v

/Designs/gdpro]/component /work/toplevelsd_sb/FABOSC_0/toplevelsd_sb_FABOSC_0_OSC.v

/Designs/gdproi/component /work/toplevelsd_sb/toplevelsd_sb.v

/Designs/gdpro]/component /work/toplevelsd_sb_MSS/toplevelsd_sb_MSS.v

.100/rtl/vlog/core/coreconfigp.v

UOUOUDUUUDBDUU UYL

HDL source files for Synopsys SynplifyPro Synthesis tool:
D:/Designs/gdpro]/component/work/toplevelsd_sb/FABDDR_0/toplevelsd_sb_FABDDR_O_FDDRC_syn.v
D:/Designs/gdproj/component/Actel/SgCore/0SC/2.0.101/0s¢c_comps.v
D:/Designs/gdproj/component /work/toplevelsd_sb_MSS/toplevelsd sb_MSS_syn.v

Focus on the following Component Manifest Reports:
+ If you use SmartFusion 2 or IGLOO 2 System Builder, read the file <system builder

name> sb manifest.txt.

+ Ifyou instantiated cores into a SmartDesign, read the file
<smartdesign name> manifest.txt.

+ If you created components for cores, read the <core component name> manifest.txt.

You must use all Component Manifests Reports that apply to your design. For example, if your
project has a SmartDesign with one or more core components instantiated in it and you intend
to use them all in your final design, then you must select files listed in the Component Manifests
Reports of all those components for use in your design flow.

2.3. Interpreting Manifest Files (asa question)

When you open a component manifest file, you see paths to files in your Libero project and pointers
on where in the design flow to use them. You might see the following types of files in a manifest file
based on the device family you are targeting:

+ HDL source files for all Synthesis and Simulation tools
« HDL source files for Synopsys SynplifyPro Synthesis tool
+ Stimulus files for all Simulation tools
+ Configuration files to be used for all Simulation tools
+ Firmware files for all Software IDE tools
+ Configuration files to be used for Programming
+ Configuration files to be used for Power Analysis
The following is the Component Manifest (example of a SmartFusion 2 System Builder component).
HDL source files for all Synthesis and Simulation tools:
D:/Designs/g4proj/component/work/toplevelsd sb/CCC_0/toplevelsd sb CCC 0 FCCC.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite addrdec.v
D:/Designs/gdpro’j/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite defaultslavesm.v

D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite slavearbiter.v
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D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite masterstage.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite slavestage.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite matrix4x16.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreConfigP/7.1.100/rtl/v1og/core/
coreconfigp.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreResetP/7.1.100/rtl/v1og/core/coreresetp.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreResetP/7.1.100/rtl/v1og/core/
coreresetp pcie hotreset.v
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/toplevelsd sb FABDDR 0 FDDRC.v
D:/Designs/g4proj/component/work/toplevelsd sb/FABOSC 0/toplevelsd sb FABOSC 0 OSC.v
D:/Designs/g4proj/component/work/toplevelsd sb/toplevelsd sb.v
D:/Designs/g4proj/component/work/toplevelsd sb MSS/toplevelsd sb MSS.v

HDL source files for Synopsys SynplifyPro Synthesis tool:
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/toplevelsd sb FABDDR 0 FDDRC syn.v
D:/Designs/g4proj/component/Actel/SgCore/0SC/2.0.101/0osc_comps.v
D:/Designs/g4proj/component/work/toplevelsd sb MSS/toplevelsd sb MSS syn.v

Stimulus files for all Simulation tools:
D:/Designs/g4proj/component/work/toplevelsd sb/subsystem.bfm
D:/Designs/g4proj/component/work/toplevelsd sb MSS/CM3 compile bfm.tcl
D:/Designs/g4proj/component/work/toplevelsd sb MSS/user.bfm
D:/Designs/g4proj/component/work/toplevelsd sb MSS/test.bfm
D:/Designs/g4proj/component/Actel/SmartFusion 2MSS/
1.1.500/peripheral init.bfm

Firmware files for all Software IDE tools:
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/sys config fddr define.h
D:/Designs/g4proj/component/work/toplevelsd sb MSS/sys config mss_clocks.h
D:/Designs/g4proj/component/work/toplevelsd sb MSS/sys config mddr define.h

Configuration files to be used for all Simulation tools:
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/FDDR init.bfm
D:/Designs/g4proj/component/work/toplevelsd sb MSS/MDDR init.bfm

Configuration files to be used for Power Analysis:
D:/Designs/g4proj/component/work/toplevelsd sb MSS/MDDR init.reg
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/FDDR init.reg

Each type of file is a necessary downstream in your design flow. The following sections describe
integration of the files from the manifest into your design flow.
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Constraint Generation (s question)

When performing configuration and generation, make sure to write/generate the SDC/PDC/NDC
constraint files for the design to pass them to Synthesis, Place-and-Route, and Verify Timing tools.

Use the Derive Constraints utility outside of the Libero environment to generate constraints instead
of writing manually. To use the Derive Constraint utility outside of the Libero environment, you
must:

*  Supply user HDL, component HDL and component SDC/NDC constraint files
+ Specify the top level module
+ Specify the location where to generate the derived constraint files

The SDC/NDC component constraints are available under <project>/component/work/

<component name>/<instance name>/ directory after component configuration and generation.

Important:

+ If using RTG4FCCCECALIB core for RTG4 designs, you must supply the
component NDC constraint file and specify the location to generate NDC
constraints for your design.

+ If using CoreConfigP and CoreResetP for SmartFusion 2 MSS, you must specify
the location to generate PDC constraints.

For more details on how to generate constraints for your design, see Appendix D—Derive
Constraints.
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4. Synthesizing Your Design (asa auestion)

One of the primary features of the Custom Flow is to allow you to use a third-party synthesis
tool outside Libero. The custom flow supports the use of Synopsys SynplifyPro. To synthesize your
project, use the following procedure:

1. Create a new project in your Synthesis tool, targeting the same device family, die, and package
as the Libero project you created.
a. Import your own RTL files as you normally do.

b. Set the Synthesis output to be Structural Verilog (. vm) or edif netlist (. edn).

2. Import Component HDL files into your Synthesis project:
a. For each Component Manifests Report:

i. Foreach file under HDL source files for all Synthesis and Simulation tools, import the
file into your Synthesis Project.

ii. Also, import all files under HDL source files for Synopsys SynplifyPro Synthesis tool.

3. Import the previously generated SDC file through the Derived Constraint tool (see Appendix
B—Sample SDC and PDC Constraints) into the Synthesis tool. This constraint file constrains the
synthesis tool to achieve timing closure with less effort and fewer design iterations.

Important: If you plan to use the same *. sdc file to constrain Place-and-
Route during the design implementation phase, you must import this * . sdc
into the synthesis project. This is to make sure that there are no design
object name mismatches in the synthesized netlist and the Place-and-Route
constraints during the implementation phase of the design process. If you do
not include this *. sdc file in the Synthesis step, the netlist generated from
Synthesis may fail the Place and Route step because of design object name
mismatches.

4. Import Netlist Attributes * . £dc, if any, into the Synthesis tool.
5. Run Synthesis.

The location of your Synthesis tool output has the *.edn or *.vm netlist file generated post
Synthesis. You must import the netlist into the Libero Implementation Project to continue with
the design process.

@ MICROCHIP


https://www.microchip.com/askaquestion?pub_guid=GUID-7E5C0B1E-64A3-47B9-8651-373CCC35329A&pub_lang=en-US&pub_ver=16&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-918E5D92-7C92-4770-A4E6-C35DFEA66396&cover_title=SmartFusion%202%2C%20IGLOO%202%2C%20RTG4%20Custom%20Flow%20User%20Guide&tech_support_link=NA&revision_letter=P&source=PDF&title=Synthesizing%20Your%20Design

5. Simulating Your Design sa question)

To simulate your design outside of Libero (that is, using your own simulation environment and
simulator), perform the following steps:

1. Design Files
a. Pre-Synthesis simulation:
+ Import your RTL into your simulation project.

+ For each Component Manifests Report.

- Import each file under HDL source files for all Synthesis and Simulation tools
into your simulation project.

+ Compile these files as per your simulator's instructions.

b. Post-synthesis simulation:

+ Import your post-synthesis *.edn or *.vm netlist (generated in Synthesizing Your
Design) into your simulation project and compile it.

c. Post-layout simulation:

+ First, complete implementing your design (see Implementing Your Design). Make sure
that your final Libero project is in post-layout state.

+ Double-click Generate BackAnnotated Files in the Libero Design Flow window. It
generates two files:

<project directory>/designer/<root>/<root> ba.v/vhd <project directory>/designer/
<root>/<root> ba.sdf

+ Import both of these files into your simulation tool.

2. Stimulus and Configuration files:
a. For each Component Manifests Report:

+ Copy all files under the Configuration files to be used for all Simulation
tools and Stimulus Files for all Simulation Tools sections to the root
directory of your Simulation project.

b. Make sure that any Tcl files in the preceding lists (in step 2.a) are executed first, before the
start of simulation.

c. For SmartFusion 2 only:

* Review the subsystem.bfm file. Based on your usage of the MDDR, FDDR, or SerDes,
make sure that the following lines are present (or absent) in the subsystem.bfm file —
their presence indicates that the Component is used in your design. Absence indicates
that the Component is not used:

#define USE MDDR
#define USE FDDR
#define USE_SERDESIF 0
#define USE SERDESIF 1
#define USE SERDESIF 2
#define USE_SERDESIF 3

d. eNVM_init.mem: If you use the eNVM (SmartFusion 2 or IGLOO 2), or if you use IGLOO 2
and use MDDR, FDDR, or SerDes, you must use the padmssenvmgen.exe to generate the
ENVM_ init.men file, regardless of whether or not you use eNVM. The padmssenvmgen
executable takes all the peripheral *init. reg files and the ENVM. cfg file as inputs
through a Tcl script file and outputs the ENVM_init.memn file required for simulations. This
ENVM init.men file is required for component initialization in simulation. This file must
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be copied to the simulation folder prior to the simulation run. An example showing the
padmssenvmgen executable usage is provided in the following steps.

e. MPROM.mem: If you use RTG4 pPROM, you must use the padrtupromgen.exe to generate
the UPROM.mem file. The padrtupromgen executable takes the nPROM. c£g file as inputs
through a Tcl script file and outputs the uPROM. mem file required for simulations. This file
must be copied to the simulation folder prior to the simulation run.

3. Create a working folder and a sub-folder named simulation under the working folder.
The padmssenvmgen and padrtupromgen executable expect the presence of the simulation
sub folder in the working folder and the *. tcl script (steps 5 and 7) is placed in the simulation
sub folder.

4. For SmartFusion 2 and IGLOO 2 devices, copy all the component *init.reg files and the
ENVM. cfq file from the first Libero project (for component generation) into the working folder.
Examples of component *init.reg files are:

MDDR_init.reg
FDDR_init.reg
SERDESIF_Q_init.reg
SERDESIF_1_init.reg
SERDESIF_2_init.reg
SERDESIF_3_init.reg

For RTG4, copy the UPROM. c£g file from the first Libero project created for component
generation (or the UPROM. c£q file with any modified/updated contents) into the working folder.

SN T

5. IGLOO 2 device: Paste the following commands in a *. tcl script and place it in the simulation
folder created in step 3.

#Sample*.tcl for IGLOO 2 devices:

set_device -fam <family name>

—-die <internal die name>

-pkg <internal pkg name>
set mddr reg -path <path to MDDR register file/MDDR init.reg>
set fddr reg -path <path to FDDR register flle/FDDR init.reg>
set “serdesif0 _reg -path <path to SERDESIF 0 reglster file/SERDESIF 0 init.reg>
set serdesifl _reg -path <path to SERDESIF 1 _register file/SERDESIF 1 _init.reg>
set ~serdesif2 _reg -path <path to SERDESTIF 2 _register file/SERDESIF 2 _init.reg>
set serdesif3 _reg -path <path_ to SERDESIF 3 _register flle/SERDESIF 3 _init.reg>
setilnputicfg -path <path7toiENVM7conf1gurat1on7flle/ENVM cfg>
set _sim mem -path<path to ENVM Initialization File/ENVM init.mem>
gen_sim -use_init true

For the proper internal name to use for the die and package, see the *.pr7x file of the first
Libero project (used for component generation).

For an IGLOO 2 device, the argument use_init must be set to true for the gen sim command
if any of the *init.reg files are used.

Not all *init.reginthe example *.tcl may be needed. Include the reg file paths for only
those peripherals used in the design.

The set _sim mem command specifies the path to the output file ENVM_init.memthatis
generated upon execution of the script file with the padmssenvmgen executable.

6. Atthe command prompt or cygwin terminal, go to the working directory created in step 3.
Execute the padmssenvmgen command with the --script option and pass to it the * . tcl
script created in step 5.

For Windows®:

<Libero SoC release installation>/designer/bin/padmssenvmgen.exe \
--script./simulation/<Tcl _script name>.tcl

@ MICROCHIP



For Linux®:;

<Libero SoC_release installation>/bin/padmssenvmgen \
--script./simulation/<tcl script name>.tcl

7. SmartFusion 2 device: Paste the following commands in a *. tcl script and place it in the
simulation folder created in step 3.

#Sample *.tcl for SmartFusion 2 devices
set device -fam <family>
-die <internal die name>
-pkg <internal pkg name>
set input cfg -path <path to ENVM.cfg>
set_sim mem -path <path to ENVM Initialization File/ENVM init.mem>
gen_sim -use init false

For the proper internal name to use for the die and package, see the *.pr7jx file of the first
Libero project (used for component generation).

The argument use_init must be set to false for SmartFusion 2.

For SmartFusion 2 device, the set mddr reg, set fddr reg, and set serdesif (x) reg
commands are not needed. All the peripheral register initialization information/data required to
run simulations is a part of the *_init.bfm files (listed in the Component Manifests reports of
each component), which must be copied from the first Libero SoC project (used for component
generation) to the top level directory of your simulation project (outside of Libero SoC).

Use the set sim mem command to specify the path to the output file ENVM init.memthatis
generated upon execution of the script file with the padmssenvmgen executable.

8. Atthe command prompt or cygwin terminal, go to the working directory created in step 1.
Execute the padmssenvmgen command with the --script option and pass to it the *.tc1l
script created in step 7.

For Windows:

<Libero SoC release installation>/designer/bin/pad4mssenvmgen.exe \
—--script./simulation/<Tcl_script name>.tcl

For Linux:

Libero SoC release installation>/bin/pad4mssenvmgen \
--script./simulation/<tcl_script_ name>.tcl

9. RTG4: Paste the following commands in a *. tcl script and place it in the simulation folder
created in step 3.

#Sample *.tcl for RTG4 devices to generate URPOM.mem file from UPROM.cfg
set device -fam <family>
-die <internal die name>
-pkg <internal pkg name>
set input cfg -path <path to UPROM.cfg>
set _sim mem -path <path to UPROM Initialization File/UPROM.mem>
gen_sim -use_init false

For the proper internal name to use for the die and package, see the * .prjx file of the first
Libero project (used for component generation).
For RTG4, there is a provision to simulate the UPROM by specifying the UPROM. c£q file using the
set input cfgcommand.
Use the set sim mem command to specify the path to the output file UPROM. mem that is
generated upon execution of the script file with the padrtupromgen executable.

10. At the command prompt or cygwin terminal, go to the working directory created in step 3.
Execute the padmssenvmgen command with the-script option and pass to it the * . tc1 script
created in step 9.
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For Windows:

<Libero SoC release installation>/designer/bin/pa4d4rtupromgen.exe \
--script./simulation/<Tcl script name>.tcl

For Linux:

<Libero SoC release installation>/bin/pa4d4rtupromgen \
--script./simulation/<tcl script name>.tcl

11. For SmartFusion 2 and IGLOO 2 devices, after successful execution of the pa4mssenvmgen
executable, check that the ENVM init.memn file is generated in the location specified in the
set sim mem command in the *.tcl script.

For RTG4, after successful execution of the padrtupromgen executable, check that the
pPROM.men file is generated in the location specified in the set sim mem command in the
*  tcl script.

12. For SmartFusion 2 and IGLOO 2 devices, copy the generated ENVM_init.mem file into the top
level simulation project to run simulation (outside of Libero SoC).
For RTG4, copy the generated npPrROM. mem file into the top level simulation folder of your
simulation project to run simulation (outside of Libero SoC).

Important: To simulate the functionality of SoC Components, download the pre-
compiled SmartFusion 2/IGLOO 2, RTG4 simulation libraries and import them into
your simulation environment as described here. For more details, see Appendix
C—Importing Simulation Libraries into Simulation Environment.
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6. Implementing Your Design (s« auestion)

After completing the Synthesis and Post-Synthesis simulation in your environment, you must use

Libero again to physically implement your design, run timing and power analysis, and generate your

programming file.

1. Create a new Libero project for the physical implementation and layout of the design. Make sure
to target the same device as in the reference project you created in Component Configuration.

2. After project creation, remove Synthesis from the tool chain in the Design Flow window (Project
> Project Settings > Design Flow > Uncheck Enable Synthesis).

3. Import your post-synthesis *.edn or *.vm file into this project, (File > Import > Synthesized
Verilog Netlist (VM)).

O Tip: Itis recommended that you create a link to this file, so that if you re-
= synthesize your design, Libero always uses the latest post-synthesis netlist.

a. Inthe Design Hierarchy window, note the name of the root module (shown in the following
figure).

Figure 6-1. Root Module in Design Hierarchy

Design Hierarchy B X
shon: 2
4 @ work
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4. Import the constraints into the Libero project. Use Constraint Manager to import * . pdc
/* .sdc/*.ndc constraints.
a. Import /0 * . pdc constraint files (Constraints Manager > 1/0 Attributes > Import).
b. Import Floorplanning *.pdc constraint files (Constraints Manager > Floorplanner >

Import. If your design contains CoreConfigP (SmartFusion 2 and IGLOO 2 only), make sure to
import the PDC file generated through Derive Constraint tool.

c. Import *. sdc timing constraint files (Constraints Manager > Timing > Import). If your
design has any of the cores listed in Overview, make sure to import the SDC file generated
through derive constraint tool.

d. Import *.ndc constraint files (Constraints Manager > Netlist Attributes > Import). If your
design is an RTG4 design using RTG4FCCCECALIB core, then make sure to import the NDC file
generated through derive constraint tool.

5. Associate Constraints Files to design tools

@ MICROCHIP
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a. Open Constraint Manager (Manage Constraints > Open Manage Constraints View).
Check the Place-and-Route and Timing Verifications check box next to the constraint file
to establish constraint file and tool association. Associate the * . pdc constraint to Place-and-
Route and the *. sdc to both Place-and-Route and Timing Verifications. Associate the
* . ndc file to Compile Netlist.

O Tip:

If Place and Route fails with this * . sdc constraint file, import this same
* _ sdc file to synthesis and re-run synthesis.

SmartFusion 2 and IGLOO 2 only: The derived floorplanning PDC file
constrains the CoreConfigP in an optimal location for placement and
improves timing performance of the design.

6. Click Compile Netlist, and then Place and Route to complete the layout step.
7. From all Component Manifests Reports:

- For SmartFusion 2 and IGLOO 2 devices, import all the files in the Configuration files to be
used for Programming and Configuration files to be used for Power Analysis sections
using the import component data Tcl command:

import component data -module "<name of root component>"?% \

-fddr "<path to FDDR.reg>" \

-mddr "<path to MDDR.reg>" \

-serdes0 "<path to SERDESIF 0 init.reg>"
-serdesl "<path to SERDESIF 1 init.reg>"
-serdes2 "<path to SERDESIF 2 init.reg>"
-serdes3 "<path to SERDESIF 3 init.reg>"
-envm_cfg "<path to eNVM cfg>"

P

- For RTG4, import all the files in the Configuration files to be used for Programming
and Configuration files to be used for Power Analysis sections using the
import component data Tcl command:

import component data \

-module "<name of root component>"@&\
-pprom _cfg "<path to pPROM cfg>"

Important:

a.

d.

@ MICROCHIP

"name of root component" refers to the name of the top hierarchical level
of the target Libero project where files are imported. For example, see
the Figure 1-1, "name of root component" is "name of root component of
Libero Implementation Project."

All configuration files are imported with the import component data.

Tcl commands are imported to the designer/<name of root
component>/component/ folder in the Libero project directory.

For SmartFusion 2 device, if you do not run SmartPower, skip importing the
* .reg files, andyou only need to import the ENVM. c£q file. For IGLOO

2 device, you must import all *. reg and eNVM. c£g files specified in all
your relevant Component Manifests Reports.

For RTG4, only UPROM .cfq file is imported.
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8. For SmartFusion 2/IGLOO 2 devices, if you need to change eNVM content, open the Update
eNVM Memory Content dialog box (see the following figure). Changes you make in this dialog
box are saved to the eNVM * . cfqg file you imported.

Figure 6-2. Update eNVM Memory Content
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